
Question 1

You have a table named Projects created in Microsof Ofce Access 2010. You are required to make some
changes in the table's data. In which of the following views will you open the table to accomplish the
task?

A. Datasheet view
B. PivotChart view
C. Design view
D. PivotTable view

Aoswern A

Explanatonn
You should open the Projects table in the Datasheet view to make some changes in the table's data.
The Datasheet view is the default view of a table. It is used to display and modify data of the table. When
a table is opened in the Datasheet view, this view displays the table's data in columns (feldss and rows
(recordss. The frst row has column headings or feld names. In order to open a table in the Datasheet
view, a user should double-click on the table's name or choose the Datasheet View opton from the view
list. The Datasheet view of a table is given belown

Answern D and B are incorrect. In the PivotTable and PivotChart views, you can perform data analysis.
Both of them are used to organize and summarize informaton into useful analysis presentatons.



Answern C is incorrect. In the Design view, you can view and modify the structure of a table.

Question 2

Which of the following Report Layout tools is used to specify the color, width, and line style for the
outline of the selected feld of a report?

A. Arrange
B. Design
C. Page Setup
D. Format

Aoswern D

Explanatonn
The Format tool is used to specify the color, width, and line style for the outline of the selected feld of a
report. It is also used to set font size, font style, and background image.

Answern B is incorrect. The Design tool is used to apply themes, controls, and header/footer in a report.
Answern A is incorrect. The Arrange tool is used to arrange the rows and columns in a report.
Answern C is incorrect. The Page Setup tool is used to set the page layout and page size of a report.

Question 3

You have created a form named Details in Microsof Ofce Access 2010.You want to add new elements,
change the header/footer, and apply a new theme to the form. Which of the following tabs will you
choose to accomplish the task?

A. Format
B. Design
C. Element
D. Arrange

Aoswern B

Explanatonn
In order to accomplish the task, you should choose the Design tab lying in Form Layout Tools. You can
add new elements, change the header/footer, and apply themes to the form by using the Design tab.



Answern D is incorrect. The Arrange tab has various layout optons.
Answern A is incorrect. The Format tab is used to change the color and font of text and the style of
gridlines around the felds. It also includes a logo and various formatng optons.
Answern C is incorrect. This tab is not displayed in Form Layout Tools.

Question 4

In which of the following views does the program window open when a user starts Microsof Ofce
Access 2010 without opening a database?

A. Backstage view
B. PivotTable view
C. Design view
D. PivotChart view

Aoswern A

Explanatonn
The program window opens in the Backstage view when a user starts Microsof Ofce Access 2010
without opening a database. The Backstage view is a full-screen user interface model in which
commands related to managing MS Access and Access database are arranged in the form of butons and
pages. The File tab in the upper-lef corner of the program window displays the Backstage view. The
Backstage view allows a user to create, save, and check hidden metadata or personal informaton. It also
helps in discovering and using the features that are not related to the authoring features on the Ribbon.
Answern D is incorrect. The PivotChart view of a table can be used to display the data of a table in the
desired format using a graph. This view cannot be used to create or delete a feld or modify its
propertes. The data can be fltered according to felds. When the PivotChart view is opened, a blank
work area is displayed and the columns of the table are displayed in the Chart Field List window. A user
has to drag and drop the felds to view the desired result. The PivotChart view uses an Ofce Chart
Component and helps a user to create dynamic and interactve charts.



Answern B is incorrect. The PivotTable view of a table can be used to display the data of a table in the
desired format. This view cannot be used to create or delete a feld or modify its propertes. The data can
be fltered according to felds. When the PivotTable view is opened, a blank work area is displayed and
the columns of the table are displayed in the Pivot Table Field List window. A user has to drag and drop
the felds to view the desired result.



Answern C is incorrect. The Design view of a table displays its felds and datatypes. New felds can be
added to the table and assigned to a datatype. A user cannot insert data in this view. The datatype of a
feld can be formated and other table propertes such as feld size, validaton rule, etc., can be set for
the feld.



Question 5

Where can a user add any Access command as a buton in Microsof Access 2010?

A. Navigaton Pane
B. Index
C. Quick Access Toolbar
D. Macro

Aoswern C

Explanatonn
The Quick Access Toolbar in MS Access 2010 is a customizable toolbar which is displayed in the ttle bar
of the Database window. It has a set of commands or functons (save, undo/redo, and prints that are
independent of the tab on the ribbon currently displayed in MS Access. The Quick Access Toolbar can be
moved from one of the two possible locatons. A user can add any Access command as a buton to the
Quick Access Toolbar.
Answern A is incorrect. The Navigaton Pane provides an interface for all database objects, such as tables,
queries, forms, reports, macros, and modules. It is located along the lef side of the Access screen. In the
Navigaton Pane, all items are organized into groups. It is also used to show or hide the database objects.
Answern D is incorrect. In Microsof Ofce Access 2010, a macro is a database object that defnes the
actons that are required for Access to perform as a result of a defned event. It is also used to open and
execute queries, open tables, and print or view reports. A user can add simple conditons in macros to
specify when actons are performed or skipped.
Answern B is incorrect. In Microsof Ofce Access 2010, an index is a list of feld values included in a table.
It helps Access in fnding and sortng records quickly. An index stores the record's locaton based on the
columns that are part of the index. The indexed felds have unique values which make it more efcient
and faster for Access to read and fnd a specifc feld value.



Question 6

You have two tables named Customers and Orders created in Microsof Ofce Access 2010. In Orders
table, each order has a customer ID. You want to correspond it to a record in the Customers table. Which
of the following will you use to accomplish the task?
Each correct answer represents a complete soluton. Choose all that apply.

A. Entty integrity
B. Domain integrity
C. Primary key
D. Foreign key

Aoswern C aod D

Explanatonn
In order to accomplish the task, you should use the followingn
Primary keyn A table usually has a column or combinaton of columns whose values uniquely identfy
each row in the table. This column (or columnss is called the primary key. Primary key ensures that no
duplicate or null values are entered in the column (or columnss defned as primary key columns. This
enforces integrity of the table. A primary key can be created by defning a primary key constraint while
creatng or altering a table. A table can have only one primary key constraint. As primary key constraints
ensure uniqueness, they are ofen defned by using an identty column.
Foreign keyn A foreign key is a column or combinaton of columns used to establish and enforce a
relatonship between the data in two tables. This relatonship is created by adding a column(ss in one of
the tables to refer to the other table's column(ss protected by a PRIMARY KEY or UNIQUE constraint. This
column becomes a foreign key in the frst table. A foreign key can be created by defning a FOREIGN KEY
constraint when creatng or altering a table.
Answern A is incorrect. Entty integrity enforces the uniqueness of rows in a table. The uniqueness of
rows can be enforced by the identfer column(ss through indexes, UNIQUE constraints, PRIMARY KEY
constraints, or IDENTITY propertes.
Answern B is incorrect. Domain integrity enforces data validity by restrictng the data type, valid values
(using CHECK constraints and ruless, and range of possible values (using FOREIGN KEY constraintss for
columns in a table.

Question 7

Which of the following feld propertes allows you to enter a "" string in a feld to indicate that there is no
value for that feld?

A. Allow Zero Length
B. Input Mask
C. Append Only
D. IME Mode

Aoswern A



Explanatonn
The Allow Zero Length property allows a user to enter a zero-length (""s string in a feld to indicate that
there is no value for that feld.
Answern C is incorrect. The Append Only property is mainly used for memo felds. When this property is
set to 'Yes', it creates a feld value history to add new text to the feld.
Answern D is incorrect. The IME Mode property is related to East Asian languages.
Answern B is incorrect. The Input Mask property is used to specify that the feld value should conform to
the patern set by the mask.

Question 8

You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista computer on
which Microsof Ofce 2010 is installed. The computer has a database named Sales created in MS Access
2010. You do not want to lose valuable data even when your computer encounters a problem. In order to
save the data, you have to make backup copies of your database on a regular basis. Choose and re-order
the steps that you will take to accomplish the task.

Aoswern

Explanatonn Take the following steps to back up an Access databasen
1.Save and close all objects in the database.
2.Click the File tab and then click the Save & Publish buton.



3.Select the Save Database As opton.

4.Click the Back Up Database opton and then click the Save As buton.



Question 9
You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based
computer with Microsof Ofce 2010 installed on it. You want to ensure that the databases created in
Microsof Ofce Access 2010 save in the Microsof Access 2003 format. Which of the following optons
will you choose in the Access Optons dialog box to accomplish the task?

A. General
B. Object Designers
C. Client Setngs
D. Current Database

Aoswern A

Explanatonn
In order to accomplish the task, you will choose the General opton in the Access Optons dialog box. This
opton opens a page that includes the Default fle format drop-down list as shown in the image given
belown



You can change the format of any of the previous versions of Microsof Access.
Answern D is incorrect. The Current Database opton includes the setngs for the currently used
database.



Question 10

Which of the following propertes binds the forms and reports to a source from which data is to be
retrieved?

A. RecordSource
B. ControlSource
C. Can Grow
D. RowSource

Aoswern A

Explanatonn
The RecordSource property belongs to the form and report objects. This property binds the object to a
source from which data is to be retrieved. This source can be a table or a query. When a form or a report
is bound to a table or a query, the controls can be bound to a column of the table through the
ControlSource property.
Answern C is incorrect. The Can Grow property allows a control to adjust its dimensions according to the
contents present in the control. A control grows vertcally to adjust its contents so that all the contents
can be displayed. The default value of the Can Grow property is false.
Answern B is incorrect. The ControlSource property bounds a control to a feld of a table. If a control is
bound to a feld by using this property, the control is known as a bound control. If the value of this



property is blank, the control is known as an unbound control. If the ControlSource property contains an
expression, the control is known as a calculated control.
Answern D is incorrect. The RowSource property belongs to the combo box and list box controls. When
these controls are bound to a column by the RowSource property, all the data of the column is displayed
in the list box or the combo box.

Question 11

You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based
computer with Microsof Ofce 2010 installed on it. The computer has a database named Customers
created in Microsof Ofce Access 2010. You want to fnd all customer records where the contact
person's ttle is Owner and the person is located either in Portland or in Eugene. Which of the following
flter features will you use to accomplish the task?

A. Filter By Selecton
B. Filter By Record
C. Advanced Filter
D. Filter By Form

Aoswern D

Explanatonn
In order to accomplish the task, you should use the Filter By Form feature. The Filter by Form feature is
used to flter records based on the values in felds of a table, query, or form. It displays a fltering
datasheet with blank felds. Each blank feld is a combo box that contains a list of all the entries made in
those felds. A user can select a value from this list or enter a new value. It is easy to use the Filter by
Form feature when a table contains only a few felds.
Answern A is incorrect. The Filter by Selecton feature is used to flter records based on the current
selecton in a feld.
Answern C is incorrect. The Advanced Filter feature is used to create a simple query on a single table.
Answern B is incorrect. There is no such feature as Filter by Record in Access 2010.

Question 12

You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based
computer with Microsof Ofce 2010 installed on it. The computer contains two databases named
Shippers and Orders created in Microsof Ofce Access 2010. A one-to-many relatonship is created
between both tables. You want to delete a Shipper. The shipper that you want to delete has orders in the
Orders table. When you delete the Shipper record, these orders will become "orphans". The orders will
stll include a shipper ID, but this ID will not be valid. What will you do to prevent these orphans?

A. Cascade delete related records.
B. Enforce domain integrity.
C. Cascade update related felds.
D. Enforce referental integrity.



Aoswern D

Explanatonn
To prevent these orphans, you should enforce referental integrity. Referental integrity means that the
foreign key in any referencing table must always refer to a valid row in the referenced table. Referental
integrity ensures that the relatonship between two tables remains synchronized during updates and
deletes. For a foreign key to be valid, it must contain either the value NULL, or an existng key value from
the primary or unique key columns referenced by the foreign key. To enforce referental integrity, a
foreign key column link to the primary key column should be created in the related table.
Answern C is incorrect. You can cascade update related felds to update all afected rows as part of a
single operaton.
Answern B is incorrect. Domain integrity enforces data validity by restrictng the data type, valid values
(using CHECK constraints and ruless, and range of possible values (using FOREIGN KEY constraintss for
columns in a table.
Answern A is incorrect. You can cascade delete related records to delete a row and all related records.

Question 13

Choose and re-order the steps that you will take to create a report based on the Stafs table in Microsof
Ofce Access 2010.

Aoswern

Explanatonn Take the following steps to create a report in Microsof Ofce Access 2010n
In the Navigaton pane, click the table that is required to be used in the report.



Click the Create tab.

Question 14
You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based
computer with Microsof Ofce 2010 installed on it. The computer has a database named
OrdersDatabase created in Microsof Ofce Access 2010. The database contains several tables. You have
created a report named OrdersReport, which is connected to a table named OrdersTable. Afer some
days, you have renamed the table as OrdersInfo. How will this change afect the report?

A. The report will not get afected.
B. The report will look blank.
C. The report will generate an error.
D. The report will be disconnected.

Aoswern A

Explanatonn
Afer renaming the table, you will fnd that the report will not get afected. The report will remain
connected to the table and work successfully.
Answern D is incorrect. The report will remain connected to the table and work successfully.
Answern C is incorrect. No error will be generated afer renaming the connected table.
Answern B is incorrect. The report will display the informaton from the connected table.

Question 15

Which of the following is located along the lef side of the Access screen and provides an interface for all



database objects?

A. Navigaton Pane
B. Quick Access Toolbar
C. Object Dependencies pane
D. Applicaton part

Aoswern A

Explanatonn
The Navigaton Pane provides an interface for all database objects, such as tables, queries, forms,
reports, macros, and modules. It is located along the lef side of the Access screen. In the Navigaton
Pane, all items are organized into groups. It is also used to show or hide the database objects.
Answern B is incorrect. The Quick Access Toolbar in MS Access 2010 is a customizable toolbar which is
displayed in the ttle bar of the Database window. It has a set of commands or functons (save,
undo/redo, and prints that are independent of the tab on the ribbon currently displayed in MS Access.
The Quick Access Toolbar can be moved from one of the two possible locatons. A user can add any
Access command as a buton to the Quick Access Toolbar.
Answern C is incorrect. The Object Dependencies pane is available on the Relatonships group in the
Database Tools tab. It demonstrates the interactons or dependencies of all database objects. It helps in
preventng record sources from being accidentally deleted. It also displays how other objects are
afected by the design change whenever any change is made in the design of an object.
Answern D is incorrect. An applicaton part is a template available in Microsof Ofce Access 2010. It can
be added to an existng database. It is used to extend the functonality of an Access database. It can
include only a single table or a number of database objects, such as tables, forms, reports, and even
relatonships. A user can open up the Applicaton Parts gallery in order to view the built-in parts.


